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1 Introduction 
The Domestic Violence System was created by the Office of Court Administration 
(OCA) in conjunction with the New York State Police as mandated by The Family 
Protection and Domestic Violence Intervention Act of 1994.  WebDVS is a web-based 
system used to enter information on orders of protection into the OCA database.  From 
there it is electronically transmitted to the New York State Police Information Network 
(NYSPIN) system.  WebDVS collects and stores all order of protection and warrant 
information issued by the courts of the State of New York - including all Family Courts, 
Criminal Courts, Supreme Matrimonial Terms, and Town and Village Justices.  The 
system also prints the actual orders and can generate a number of reports for system 
users.  The order data is stored for several years after the orders become inactive 
according to a specific records retention schedule, thus providing for inquiry into the 
domestic violence history of individuals.  Access to this Registry is currently available to 
judges, courts, and other qualified agencies. 
 
Searches into the Registry may be executed by Name, Case Number (Docket Number), 
Order Number, NYSID, and/or Social Security Number. They may be conducted on a 
statewide or regional basis, or limited to a specific court or county.  An online “Order 
Recap,” which prints all order of protection information for a given order, is available to 
judges to assist in the adjudication of domestic violence cases.  This information can be 
used, for example, by a Criminal Court judge to view terms of an existing Family Court 
order of protection, or to validate that an active order of protection exists in another 
court.  It also provides information on the terms and conditions of the order, and who is 
protected as such. 
 
Immediately upon entry into WebDVS, select order information is transmitted to the New 
York State Police Information Network (NYSPIN), which is a “Hot File” repository, 
storing only active order of protection information. The NYSPIN system is specifically 
designed for inquiry purposes by law enforcement and is a tool for the Mandatory Arrest 
Statute enacted in January 1996.  Local Law Enforcement Agencies, upon serving 
orders of protection, update the NYSPIN system with the associated service 
information.  This data is immediately forwarded back to the OCA database. 
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2 Getting Started 
2.1 Book Marking the Site 

Setting a bookmark will provide easy retrieval of the WebDVS site.  To set a bookmark, 
bring the site's initial window to the front and set a bookmark from there.  

Depending on the configuration of the computer, use one of the following methods to 
retrieve the site's initial window:  

• Hold the “Alt” key and press “Tab.”  
• Select the window from the task bar at the bottom of the screen (to the right of 

the 'Start' menu).  
• Close the Login window when it appears. This will return the initial window where 

the user can set a bookmark.  After doing so, the user may return to the Login 
window by clicking the browser's Refresh button.  

2.2 Login  

The Login window shown below is displayed upon first accessing the URL for the 
application. This Login window is shown on a background that highlights the OCA 
security statement. This statement explains that the application is the property of the 
New York State Unified Court System, and that it is to be utilized only by authorized 
users for official Unified Court System business. The statement explains that by logging 
onto the system, the user consents to have read, understood, and agreed to such 
terms.  

 
 
Once the Login window is displayed, enter the User Name and Password and click the 
Sign In button to begin.   Logins and Passwords are assigned by the Security 
Administration Unit of OCA.  
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Note: Please be aware that both the User Name and Password are case sensitive. 

In accordance with security standards, the user is required to change his or her 
Password periodically.  For more information on Password change requirements, see  
section 2.4.1.1 Change Password. 

2.3 Main Menu 

After successfully logging into the application, the Main Menu window is displayed as 
shown below.  Depending on the user’s security level, the user may see some or all of 
the buttons displayed on the left of the screen (Left Task Panel).  These buttons 
represent the various functions that can be performed from this window.  

 

2.4 Menu Bar 
A number of the functions within this application can be accessed from a ‘menu bar’ 
similar to a standard Windows application. 

2.4.1 File 

From the File menu, the user can change his or her Password, switch to a different 
court (if the user’s account permits access to multiple courts), or Log Out of the 
application.  
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2.4.1.1 Change Password 

The user is required to change his or her Password periodically.  To do so (manually) at 
any time, choose File → Change Password to reach the screen below: 

 

Enter the current (Old) Password, then type the New Password twice, and click the 
Change Password button to complete the change.  

Note: Please be aware that both the User Name and Password are case sensitive.  

In accordance with security standards, the Password expires after 60 days.  The system 
maintains a history of the user’s previous Passwords, so the user cannot reuse an old 
Password in the future.  All Passwords must meet the following security guidelines:  

Passwords must be:  

• At least 6 characters long  
• Composed of at least one character from at least 3 of the following 4 categories:  

o Lower-Case Letters  
o Upper-Case Letters  
o Numbers  
o Special Characters (!@#$%^&*()-_+=<>?/[]{}|) 

2.4.1.2 Change Court 

If the user’s account permits access to multiple courts, the user may change the current 
active court by choosing File → Change Court.  Select the desired court from the list 
displayed, and then click the Change Court button to activate the selection and return to 
the Main Menu.  Clicking the Cancel button returns the user to the Main Menu without 
changing the current court.  

2.4.1.3 Log Out 

When finished using the WebDVS application, the user should log out so that no other 
person may use that account.  To do so, choose File → Log Out or click the Log Out 
button at the bottom left side of the screen.  
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2.4.2 Admin 

From the Admin menu, (with the proper security level), it is possible to delete an Order 
Number or Case Number, or change an Order Number or Case Number. 

2.4.3 Help 

The Help menu provides access to information on what setting to use for various 
popular browsers, such as Internet Explorer or Firefox.  There are explicit instructions 
on how to use the Inquiry features of this application, as well as a demonstration of the 
application.  Additionally, a copy of this User Manual is available for view and print, and 
the HelpDesk contact number is listed if further assistance is needed.  

2.4.4 Announcements 

Announcements are added and updated on the Main Menu whenever enhancements 
are added to the WebDVS application or information needs to be relayed to system 
users.  

3 Add New 
The Add New function is used to enter a new order.  From the Main Menu, click the Add 
New button from the Left Task Panel to reach the window shown below: 
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Enter the Case Number (docket) for the new order.  If the Case Number already exists 
in the WebDVS database, a window is displayed showing all orders associated with that 
Case Number. 
 
Note:  Orders entered in the old DVS Sybase System will not be retrieved or displayed 
here. 
 

 
 
If the Case Number (docket) is new (it did not already exist in the WebDVS database), 
the “Existing Order of Protection” box on the upper part of the window does not appear.  
Instead, the user receives a message advising no such Case Number was found: 
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In either instance, the user can click the Create Order button to create a new order or 
the Cancel button to close the window and return to the Main Menu.  The default is set 
to “System Assigned” to create the new order number, but there is an option to select 
the ‘Manually Assigned’ radio button and enter an order number manually (the format of 
the order number is a four digit year followed by a 6 digit sequence number).   
 
Note:  In this application there are no Alpha values allowed in the order # field. 
    
Each order number must be unique to a specific court.  If it is not, the application returns 
an error message saying, “Order number already exists in this court.” 
 
By selecting the Create Order button, the window shown below is displayed:  
 

 
 
This window is used throughout the application to add new orders or to update existing 
orders.  By navigating through the tabs on the top of the page, all information that is 
needed for an order can be entered.   
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3.1 Person Information Tab 
Upon entering this window, the Person Information tab is auto-selected.  For new 
orders, there will not yet be any persons in the “Persons in Docket” drop-down list.  To 
add persons to the order, click the Add New button and the window shown below is 
displayed:  
 

 
 
Note:  The Select, Add (New), and Delete buttons are used throughout the application.  
See section 12.2 Conventions of the Appendix for a detailed explanation of how these 
controls work. 
 
Enter as much information as possible for each person listed on the order of protection.  
When entering person information, at least one character for the First Name field is 
required, and at least two characters for the Last Name field are required.  The Date of 
Birth (DOB field) is required, or the ‘Unk’ box must be checked if the DOB is unknown.  
Also, the Sex and Race fields are required.  All other fields on the window are optional, 
but should be entered if known.   
 
Note:  Always include the NYSID # when one is available.  
 
From this window, the user can also add an AKA (alias), address, and contact 
information for the person.   
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3.1.1 Alias Information 

Select the Add/Edit Alias… button to add an alias.  Click the Add New button and the 
window displays name fields in which to enter the alias information.   At least one 
character for the First Name field is required, and at least two characters for the Last 
Name field are required.   
 

 

3.1.2 Address Information 

Select the Add/Edit Address… button to add an address.  Click the Add New button and 
the window displays address fields in which to enter the information: 
 

 
 
Partial addresses cannot be added.  The “Address Information” box requires the Street, 
City, State, and Zip Code fields, along with the Address Confidential field.  If the 
address is marked as confidential, the information is displayed in red and not displayed 
on the order.  ‘Home’ is the default for “Address Type” but there are other options in the 
drop-down list.   
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If applicable, utilize the “Address to Copy” drop-down list to select an address already 
entered for another person on the order.  Doing so will prevent the user from having to 
enter (type) the same information more than once. 
 
Upon completion of the address information, click the Apply button to save it or the OK 
button to save the information and close the window.  The new address will appear in 
the box at the top of the window replacing the words “NEW.”   
 
The Select or Delete buttons can then be used to modify or delete this address. 
 
The OK button brings the user back to the previous window, and the Cancel button 
does the same without saving any information from the address window.  

3.1.3 Contact Information 

Contact information can be entered in the “Contact Info” box.  Home phone is defaulted 
but other options are available in the drop-down list.  If contact information is added, the 
‘Confidential’ indicator must be selected.   
 

 
 
If more than one contact must be added, use the Additional Contact window as outlined 
below. 

3.1.4 Additional Contact Information 

Select the Add/Edit Additional Contacts… button to add an additional contact.  Click the 
Add New button and the window displays contact type fields in which to enter the 
information: 
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The additional contact information that can be added includes e-mail address, phone 
numbers, fax numbers, or pager numbers.  Click the Apply button to save the 
information to the database or the OK button to save the information and close the 
window.  The Reset button returns the window to its original state.   
 
When finished entering any additional contact information, click the OK button to return 
to the previous window.  The Cancel button returns the user to the previous window 
without saving any entered information. 

3.2 Charges Tab 
The Charges tab is used for criminal orders (all other order types can ignore this tab).  
When entering a criminal order, select this tab to enter the charges.  An example 
window is shown below:   
 

 
 
Upon first entering the Charges tab, click the Add New button to the right of the 
window.  There are three options for entering charges:  
 
Common Charge: If this radio button is selected, the user can choose from a list of 
common charges as designated by the user’s court.  Adding common charges is an 
Administrative function that is not yet available, but will be an option for Local 
Supervisors.  To add common charges at this time, contact the Family Protection 
Registry Center.  
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Browse Charges:  If this radio button is selected, a window displays allowing the user 
to select a charge from the DCJS Charge Dictionary: 
 

 
 
The “Law Code” drop-down list contains all codes in the DCJS Charge Dictionary.  The 
window will display Law Code: PL as the default.  In the “Article/Section” field, enter all 
or part for the charge article and section.  Click the Find Charge(s) button to retrieve a 
list of all charges that meet the criteria specified: 
 

 
 
Select the applicable charge to attach to the order being entered.  
 
The default is set to search all charges, meaning all charges in the DCJS Statewide 
Charge Dictionary as well as the common and local charges that the user’s court has 
entered.  Alternatively, the user can choose to search only the Statewide Dictionary or 
the Local/Common charge dictionary as defined by the court.  
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Force Charge:  Select this radio button when the charge information is incomplete on 
the order.  Enter either the Law Code and Article/Section OR description.   
Once the appropriate charge or charges are selected, the user must select whether the 
charge is an arrest charge or a conviction charge.  The user must choose one of the 
options, however both can be selected at the same time if applicable.    
 
If there is more than one count for the charge, the count field can be updated (“1” is 
defaulted).     
 
If the charge is an attempt charge, click the ‘Attempt’ box.  This will display the charge 
with the appropriate 110- in front of the charge to indicate it is an attempt.   

3.3 OP Data Tab 
The OP Data tab is used to enter the type of order and the basic order information.  
The user must select the type of order from the “Form Type” drop-down list (Criminal - 
Family Offense, Criminal - Non-Family Offense, Family, and Supreme Matrimonial), and 
whether the order is a Temp(orary) or Final order of protection, to reach the window 
below: 
 

 
 
Select the Judge, Part, and Attendance from the drop-down list. Judge and Part are 
required.  The drop-down lists are populated with information as defined by the court.  If 
a particular part is not in the drop-down list, use DV as the default. 
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The “Judge” drop-down list contains the judges assigned to the user’s court.  If the 
judge who issued the extension is not in this drop-down list, select the Find Judge… 
button.  This displays a pop-up window that allows the user to search the Statewide 
Judge Dictionary and select the judge required. 
  
Complete the fields in the “Applying Party Info” box and “Against Party Info” box as 
applicable (the drop-down lists contain the names of the persons entered on the Person 
Information tab).  Check the ‘Youthful Offender’ box if applicable.  The ‘Issue Date’ and 
‘In Effect Until’ date are required.  ‘Return On Warrant’ should only be used if a warrant 
has been issued and the order will expire upon the return on warrant.  ‘Issued as a 
Condition Of’ refers to conditions of bail and should be selected as applicable (these 
conditions are not required).   
 
There must be at least one entry in the “Order Filed With Police Agencies” box.  The 
primary law enforcement agency as defined by the court is defaulted, however 
additional agencies can be selected using the Add button.   If the law enforcement 
agency is not part of the Local Agencies listed, select the ‘All Agencies Beginning with’ 
radio button.  This will allow the search of the Statewide Law Enforcement Dictionary.  
This search can be done by lead characters of name or ORI.   
 
Click the Apply button to save the information to the database or select another tab to 
save the information and continue.  The Reset button returns the fields to the original 
state. 
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3.4 Terms & Conditions Tab 
The Terms & Conditions tab is used to enter all of the terms and conditions that 
appear on the order of protection.  This tab is shown below: 
 

 
 
Select the particular terms or conditions to be included on the order.  If a selection is 
made from the “Terms & Conditions” box and it requires additional information, the 
space to the right of the box provides the necessary fields (such as a free-form text box 
or an address field).  In the example below, David Demo must “Stay Away” from Daisy 
Demo AT ALL TIMES: 
 

 
 
Once the additional information has been added, click the Add button, and the term or 
condition populates into the box at the bottom of the window (see screenshot below).  
The terms and conditions listed in this box are printed on the order of protection.   
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To delete a term or condition from the bottom box, select it and click the Delete button.  
To change some aspect of the term or condition in the bottom box, select it and click the 
Edit button.  This will move it back up to the top box where it can be edited.  Once 
edited, click the Replace button and the condition will be updated.  

3.4.1 Grouped Conditions 

In order to expedite entering the most commonly used terms and conditions, a shortcut 
was added in the form of the Grouped Conditions… button.  Selecting this button 
automatically adds the Stay-away terms 1A through 1E, Condition 02, and Condition 14.  
Once selected, a window opens displaying the above conditions, each of which is 
highlighted.  The user then selects the name associated with the conditions and clicks 
the Add to Terms button.  This populates the Terms and Conditions Data window.  If 
one of these pre-selected conditions should not be included, simply de-select it.  
 
Each additional condition can also be added by selecting it, adding the required 
additional information and clicking the Add button.    
 
If the “1F Stay Away (Other)” or “99 Other” term or condition is selected, a free-form text 
box is provided in the space to the right of the “Terms & Conditions” box to enter the 
information.   
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3.4.2 Common Text 

Common Text fields can be used to enter wording or terminology commonly used by a 
judge or the court in general.  Once added to the Common Text Dictionary, the user can 
access this common text by clicking on the Common Text button specific to each term 
or condition.  Common Text will be added at the request of the court and can be 
designated for a specific judge or for the court.  See example below: 
 

 
Adding common text is an Administrative function that is not yet available, but will be an 
option for Local Supervisors.  To add common text at this time, contact the Family 
Protection Registry Center.    
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3.5 Service Tab 
The Service tab is used to enter information about the service of the order.   
 
If the ‘Defendant Advised in Court’ check box is checked, the ‘Yes’ radio button remains 
selected and the issue date of the order populates the fields for the service date (see 
screenshot below).  If the date is different, the user may make the change as 
appropriate.  If no time is entered, the system defaults to 12:00 am. 
 

 
 
 
If the ‘Defendant Advised in Court’ check box is not checked, the ‘No’ radio button must 
be selected and the user must choose one of the radio buttons in the “Police Service 
Req’d” box to indicate whether or not Police service is required. 
 

 
 
 
The Person Information, OP Data, Terms & Conditions, and Service tabs are 
required for all orders.  The two remaining tabs are described below. 
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3.6 Additional Information Tab 
The Additional Information tab (see screenshot below) is used to enter any additional 
information that should appear on the order of protection.  This includes AKA(s), CC’s, 
to whom copies of the order should be given, and if the order is issued on behalf of 
anyone.  All persons names including AKA(s) and On behalf Of must be added on the 
Person Information tab to then be available on this window.  The names appear in the 
boxes on the left of the window and can be added to the order by selecting it and 
clicking the Add button.  If a name is added in error, select it from the boxes on the right 
and click the Remove button.  
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3.7 Warrant Tab 

The Warrant tab is used to enter a warrant associated with an order of protection, and 
any outcomes for that warrant.  
 
When the window first displays, only the “Existing Warrants” box appears at the top of 
the window.  This box contains a list of all warrants already entered for this order, 
including the Name of the person against whom the warrant was issued, the Issue Date, 
and any Outcome and Outcome Date for the warrant.   
 
 
To add a new warrant, click the Add New button and the “Warrant Information” box 
appears (see screenshot below).  Add the Name, Issue Date, and any Outcome and 
Outcome Date for the warrant.  Click the Apply button to add it to the “Existing 
Warrants” box. 
 

 
 
To modify information on an existing warrant, choose the warrant from the “Existing 
Warrant” box and click the Select button.  The “Warrant Information” box displays with 
the information for the user to modify. 
 
To delete a warrant, select it from the “Existing Warrants” box and click the Delete 
button. 
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4 Submitting the Order 
After entering all necessary information for the new order, click the Submit button to 
create and save the order to the database, as well as electronically transmit the order 
to NYSPIN.  A PDF version of the order is created as shown below: 
 

 
 
This order can be printed and disseminated as the legal order, and can be printed with 
multiple copies.  To print the order, click the printer icon at the top of the PDF screen.   
 
 
 
 
 
 
 

Office of Court Administration  25 
Division of Technology  

 



 
 
 
WebDVS User Manual 

5 Edit Existing 
To edit or modify an existing order, click the Edit Existing button on the Left Task Panel 
of the Main Menu.  The following window is displayed:   
 

 
 
In the “Case Information” box, the user can search by Case Number (which shows all 
orders associated with that case number) or by Order Number (which takes the user 
directly to that order).  If a Case Number is entered that does not exist, the Add New 
window (used to create a new order) is displayed.  If a Case Number is entered that 
does exist, the window shown below is displayed.  Choose the order and click the 
Select button. 
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Note:  The Edit Existing button on the Right Task Panel off of the Inquiry Results page 
has exactly the same function.  
 
Note:  This option is only available to users from the court that originated the order. 
 
This feature should be used to correct or update missing data.  A new order number will 
not be created using this feature and any changes will overwrite the original data.  
Please do not use this feature to modify conditions on an existing order unless the 
order was incorrect.  If the order has already been disseminated, a copy of this 
corrected order should be disseminated as well.   

6 In Process 
6.1 Save IP button 
In proceeding through the various tabs to create an order (as described in section 3 Add 
New), there is a button on the Right Task Panel labeled Save IP.  When this button is 
selected, the order that the user is currently working on is saved exactly “as is” - as an 
incomplete, or “In Process” order.  This allows the user to save the existing data for 
retrieval and completion at a later time.  
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Office of Court Administration  27 
Division of Technology  

 



 
 
 
WebDVS User Manual 
6.2 In Process Function 
To retrieve and complete an order in process, click the In Process button on the Left 
Task Panel of the Main Menu.  Upon entering this window, the ‘User’ radio button is 
selected and the user’s name is populated in the adjacent field.  This indicates that 
when the Search button is selected, the default is set to search for all orders that are “In 
Process” for that specific user.  The user can also select all “In Process” orders for the 
user’s court. 
 

 
 
After choosing a search option and clicking the Search button, all orders found based 
on the search option are displayed in the bottom box as shown in the screenshot below: 
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Choose the order and click the Select to Complete button.  This retrieves the order as it 
was last saved.  The user can then complete the order.  Once completed, the order is 
removed from the “In Process” list. 
 
To delete an order from the “In Process” list, select it and click the Delete button.   
 
To leave the window without doing any processing, click the Cancel button. 
 
Note:  In Process orders will not be displayed through Inquiry.  IP orders are not 
transmitted to NYSPIN until completed.   
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7 Print Preview 
When proceeding through the Add New/Edit Existing tabs, there is a button on the right 
side of the window labeled Preview.  When this button is selected, a preview of the 
order being created is displayed and can be printed.  It includes as much or as little 
information as is entered.  The terms and conditions appear as check boxes on the 
preview order.  This feature can be used to print the order prior to the court appearance. 
 

 
 
 
The preview order will not be saved in the Registry database or sent to NYSPIN.  The 
order can be saved by clicking the Save IP button and later it must be finished and 
submitted.  Once submitted, it is saved to the Registry and sent to NYSPIN.   

Note:  At this time, the Preview feature is only available for Criminal family and non-
family orders. 
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8 Inquiry 
The Inquiry window allows access to information on pre-existing orders of protection by 
Name or Case Identifier.  The Case Identifiers that can be used are: Case #, Order #, 
NYSID, or SSN.  Orders can be searched by Court, County, Region, or Statewide.  The 
search default is set to include all orders, however the search can be limited to Family, 
Criminal, or Civil orders (or some combination of these), and it can be limited to Active 
Orders Only.   
 
In addition to the text included in this section, an explanation of the Inquiry function can 
be accessed through the Help menu by selecting the Inquiry button. 

Note: Orders entered through applications other than WebDVS can be viewed as read 
only. Only orders entered through WebDVS can be updated through WebDVS.  
However, orders entered in the old DVS Sybase System can be vacated through 
WebDVS. 

8.1 Search Criteria 
Selecting the Inquiry button from the Main Menu displays the following window: 
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To choose the geographical area for the search, select one of the radio buttons in the 
box at the top of the page entitled “Search Area.”  In addition to selecting the 
geographical area (Court, County, Region, or Statewide), there is an option to either 
exclude Town and Village courts from the search, or to only include Town or Village 
courts.  If one of these options is not selected, the search includes all courts in the 
geographical area chosen.  The search defaults to Statewide if no other radio button is 
selected in the “Search Area” box. 

The “Proceeding Type(s)” box permits limiting the search to a Family, Criminal, or Civil 
order (or some combination of these).  The default is all types.  The “Display” box 
permits limiting the search to Active Orders Only.  The default is all orders.  

8.1.1 Search By: Name 

When the Inquiry window first displays it allows a search for an order by Name (First 
and Last).  The user must enter at least two characters in the Last Name field and at 
least one character in the First Name field.  The program then searches the database to 
find all cases that ‘Begin With’ the characters entered.  This default can be changed by 
selecting another option in the “Find Names That” drop-down list.  The other search 
options include: ‘Match’ (exact match), ‘Reverse First And Last’ (some non-English 
names may reverse first and last names), or ‘Sounds Like’ (for example: Smith and 
Smyth).  To further limit the search, enter the necessary information into the “Limit 
Search By” box.  The search can be limited by a Date of Birth (range), Sex, and/or 
Race. 

A Statewide search requested on “Danny Demo,” will result in the window shown below: 
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The Print Results button at the bottom of the window prints these results if so desired.   

Note:  Inquiry Results should be printed in landscape mode for best results.   

8.1.2 Search By: Case Identifier 

To search by Case Identifier, select the ‘Case Identifier’ radio button.  When selected, 
the following window is displayed:  

 

This window allows a search by Case #, Order #, NYSID, or SSN.  When the Search 
button is selected, a window appears with all cases that match the information as 
entered in the ‘Case Identifier’ fields.   

As on all windows in the WebDVS application, the Clear button clears all information 
entered in the window, and the Cancel button returns the user to the previous window 
without executing any function on the opened window. 

8.2 Functions off of Inquiry Results 
Additional functions can be obtained by selecting a single row on the Inquiry Results 
window and choosing one of the buttons on the Right Task Panel.  Each of the functions 
are outlined below. 
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8.2.1 View Order Details 

When the View Order Details button is selected, the order is returned as a read only 
order.  The Case # and Order # are displayed on the right side of the window.  All the 
information entered for this order can be viewed by selecting the various tabs a the top 
of the window (Person Info, Charges, OP Data, Terms & Cond, Service, Additional 
Info, Warrant, Extension, and Violation).  When entering this window, the Person 
Info tab is auto-selected.  The “Persons in Docket” drop-down list contains all persons 
associated with this order (as shown below).  By selecting a person from the list, the 
window displays demographic information specific to that person.   
 

 
 
Note:  This option is available to all courts and all users, even if the order originated 
from another court. 
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8.2.2 View Order (PDF) 

By choosing the particular order of interest and selecting the View Order (PDF) button, 
an actual image of the order (in PDF form) presents with a watermark “COPY” displayed 
on the order.   If desired, choose the printer icon at the top of the PDF page to print a 
copy of the order. An example of such is shown below: 
 

 
 
Note:  This option is available to all courts and all users, even if the order originated 
from another court. 
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8.2.3 Order Recap 

By choosing the particular order of interest and selecting the Order Recap button, the 
order recap is available for view and print.  
 

 
 
Note:  This option is available to all courts and all users, even if the order originated 
from another court. 
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8.2.4 Extend TOP 

Select the Extend TOP button to enter extension information on an existing order of 
protection.  By choosing the particular order of interest and selecting the Extend TOP 
button, a window is displayed as shown below.  The original order information is 
displayed in the “Original Order” box at the top of the window.  Existing extensions to 
the order (if any) are displayed in the “Existing Extensions” box.   
 

 
 
To add an extension, select the Add New button.  A new window opens at the bottom of 
the screen for entry of the necessary information to extend the order as shown below:  
 

 
 
Note:  This option is only available to users from the court that originated the order. 
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In the “Order Duration” box, enter the date the extension was issued and the date it is 
extended to (‘In Effect Until’).   The ‘Date’ is divided into Month/Day/Year fields with the 
year field being the four digit year.  Instead of entering the date in the Month/Day/Year 
fields, the user can select the Calendar icon and a calendar window appears, allowing 
the selection of the desired dates.  A more detailed explanation of the calendar feature 
can be found in section 12.2 Conventions of the Appendix of this User Manual. 
 
The ‘Return On Warrant’ radio button is available for a case in which the against party is 
warranted.  Otherwise, all orders of protection must include an expiration date.  ROW is 
not available to Town and Village Courts. 
 
In addition to the extension dates, the “Attendance Info” may be entered.  Select from 
the drop-down list as applicable.   
 
The “Judge” drop-down list contains the judges assigned to the user’s court.  If the 
judge who issued the extension is not in this drop-down list, select the Find Judge… 
button.  This displays a pop-up window that allows the user to search the Statewide 
Judge Dictionary and select the judge required. 
 
In the “Court Service” box, the user may select the check box labeled ‘Defendant 
Advised in Court.’  When this is selected, the radio button labeled “Yes” (the party was 
advised in court) is automatically selected and the current date and time are populated 
in the appropriate fields.  If the date of service is not correct, the user can change it to 
the correct date and time.   
 
If the against party was not served the extension in court, select the radio button 
labeled “No,” then select the “Yes” or “No” radio button for “Police Service Req’d” as 
applicable. 
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8.2.5 Copy/Modify 

After selecting an order from Inquiry Results and selecting the Copy/Modify button, a 
window is displayed as shown below: 
 

 
 
In the “Order Number” box, the user can accept the default of ‘System Assigned’ or 
select ‘Manually Assigned’ and enter an order number.  The Copy Order button will 
copy all of the information from the old order to the new order.  At this point the user 
must then modify any of the information from the old order on the newly created order 
by going through each of the tabs and updating as necessary (for further information, 
see section 3 Add New). 
   
Note:  When Copy/Modify feature is used, the system automatically creates a new 
order number.  This feature should be used to create a new order on a case where a 
previous order has already been entered, conditions may have changed, or a Final 
order has been issued.     
 
Note:  This option is only available to users from the court that originated the order.   
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8.2.6 Edit Existing 

After selecting an order from Inquiry Results and selecting the Edit Existing button, a 
window displays that allows the user to edit or modify any information on a pre-existing 
order of protection.  
 
Note:  This feature should only be used to correct or update missing data.  A new order 
number will not be created using this feature and any changes will overwrite the original 
data.  Do not use this feature to modify conditions on an existing order unless the order 
was incorrect.  Once an order is issued and disseminated, the order should not be 
altered in any way unless a copy of this corrected order is signed and disseminated as 
well.   
 
Note:  This option is only available to users from the court that originated the order.    

8.2.7 Violations 

After selecting an order from Inquiry Results and selecting the Violations button, a 
window is displayed as shown below: 
 

 
 
The “Violation List” box displays any existing violations of the order selected.  The user 
can modify information on a given violation (Select button), add a new violation (Add 
New button) or delete a violation erroneously added to the order (Delete button). 
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To modify an existing violation, highlight the violation and click the Select button.  The 
bottom of the window displays the specific information related to that violation.  Edit or 
modify this information and apply any changes (Apply button).  An example of this 
window is shown below: 
 

 
 
Note:  This option is only available to users from the court that originated the order.  
 
To add a new violation, click the Add New button.  The bottom portion of the window is 
designed with the same fields as above, however all fields are blank.  Enter the 
information as necessary.  A comments field is also available for additional information 
related to the violation.  Upon completion, click the Apply button and the new violation 
will appear in the “Violation List” box at the top of the window.  
 
To delete an existing violation that was entered in error, select the violation from the 
“Violation List” box and click the Delete button. 
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8.2.8 Vacate Order(s) 

After selecting an order form Inquiry Results and selecting the Vacate Order(s) button, a 
window is displayed as shown below: 
 

 
 
All orders associated with this case number will be displayed in the upper portion of the 
window in the “Active Orders” box.  To vacate this order, enter the ‘Vacate Date’ and 
‘Judge.’  Select the order and click the Vacate button. This moves the order to the lower 
portion of the window into the “Vacated Orders” box (see screenshot below).  The order 
is now vacated. 
 
Note:  Orders entered through the old DVS Sybase system can also be vacated 
through WebDVS.  
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To un-vacate an order that was vacated in error, select it from the “Vacated Orders” box 
and click the Un-Vacate button.  This causes the order to move back up to the “Active 
Orders” box. 
 
To leave this window, select the Close button. 
 
Note:  This option is only available to users from the court that originated the order.  
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8.2.9 Dismiss Case 

After selecting the order from Inquiry Results and selecting the Dismiss Case button, a 
window is displayed as shown below: 
 

 
 
All orders associated with that case are displayed.  The Case # displays at the top of 
the window.  Enter a dismissed ‘Date’ and ‘Judge.’  The user also has the option to 
check the ‘Seal Case’ check box.  When the user clicks the Dismiss Case button, the 
case is dismissed and all orders associated with that case are “vacated by 
dismissal.”  If the ‘Seal Case’ box is checked, the case is sealed and no longer visible 
to any users.   
 
To leave this window, select the Close button. 
 
Note:  This option is only available to users from the court that originated the order. 
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8.2.10 Seal Case 

This function is used to seal a case that has already been dismissed.  Select an order 
from the case to be sealed, and click the Seal button to seal the entire case: 
 

 
 
By clicking the Seal button, the dismissed case is now sealed.  The message “Docket Is 
Not Sealed” changes to “Docket Is Sealed” (and the color changes from green to red).  
The Seal button also changes to read Unseal (see screenshot below).  If the user enters 
this window for a Case that is already sealed and clicks the Unseal button, the Case will 
be unsealed.   
 

 
 
To leave this window, select the Close button. 
 
Note:  This option is only available to users from the court that originated the order. 
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8.2.11 Transfer/Vacate 

The Transfer/Vacate function allows a Supreme or County Court user to choose a Local 
Court criminal order from within the county, and copy the contents to create a Supreme 
or County Court order.  After assigning a new Case Number and Order Number, the 
new Supreme or County Court order is created and the Local Court order is vacated (all 
in one function).  
 
When the Local Court order is highlighted and the Transfer/Vacate button selected, the 
following window is displayed:  
 

 
 
Enter the ‘Vacate Date’ and ‘Judge.’  Enter the new (Supreme or County Court) Case # 
and select “System Assigned” or “Manually Assigned” for the Order #. Once the 
Vacate/Transfer button is selected, the Person Information window is displayed.  All 
existing information from the vacated order is displayed.  This information can be 
modified as necessary.  If there is no need to modify any of the information from the 
vacated order, click the Submit button.  This will immediately vacate the Local Court 
order and create the new Supreme or County Court order.    
 
Note:  This function is only available to Supreme and County court users.  
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9 Reports 
There are several reports available to users of WebDVS by clicking the Reports button 
on the Left Task Panel of the Main Menu.  Reports are available and displayed in the 
drop-down list according to access level.  The following reports are available:  
 
Expired Temporary Orders Report 
 List of orders that will expire within a given month 
Order Number List Report 
 List of all orders entered by a specific court 
Order by Court or County Report 
 List of all orders entered by a specific court or county  
Order with No Service – Details 
 List of orders entered where no service information is indicated 
Orders with No Service – Totals 
 List of number of orders entered where no service information is indicated 
Outstanding Violation Report 
 List of orders with violations attached 
Outstanding Warrant Report 
 List of orders with warrants attached 
User Workload Report 
 List of number of orders entered by user or by court 
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Select the desired report from the drop-down list.  The window will display fields for the 
parameters needed for the selected report (such as date range).  In the example 
screenshot below, the Order Number List Report is selected.  If the desired search is for 
a specific user, the ‘User’ radio button is selected.  The window then displays a field to 
search for that user:  
 

 
 
For the Order Number List Report, the user can narrow the search by specifying an 
Order # Range, a specific Year, or a data entry User.   
 
An example of each report can be found in section 12.1 Reports of the Appendix of this 
User Manual. 

10 Admin 
The Admin function is not available at this time.  It will be available in future releases of 
the WebDVS application and will provide Dictionary access to Local Supervisors.  
Functions available through Admin include: 
  
Common Charges Dictionary 
Local Charges Dictionary 
Court/Judge Dictionary 
Common Text Dictionary 
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11 (Un)Seal 
This function is used to seal a case, or unseal a sealed case.  Select the (Un)Seal 
button from the Main Menu.  Enter a Case # in the designated field and click the Search 
button.  If the docket is found and is not sealed, the message will read as such: 
 

 
 
 
If the user clicks the Seal button the docket (case) will be sealed.  If the docket found 
was already sealed, the message reads as such: 
 

 
 
 
In this instance, the button is labeled “Unseal.”  If the user clicks this button the case will 
be unsealed.   
 
Note:  All orders entered under a docket (case number) that have been sealed are not 
viewable through Inquiry or NYSPIN.  
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12.1 Reports 

12.1.1 Expired Temporary Orders Report 
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12.1.2 Order Number List Report 
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12.1.3 Orders by Court or County Report 
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12.1.4 Orders with No Service - Details 
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12.1.5 Orders with No Service - Totals 
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12.1.6 Outstanding Violation Report 
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12.1.7 Outstanding Warrant Report 
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12.1.8 User Workload Report 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Office of Court Administration  58 
Division of Technology  

 



 
 
 
WebDVS User Manual 
12.2 Conventions 

12.2.1 Calendar Icon 

To the right of all date fields in the WebDVS application is a Calendar icon.  When 
selected, a calendar displays (defaulted to the current date) as shown below: 
 

 
 
Clicking on a certain date enters this information into the Date fields to the left of the 
Calendar icon.  The single arrow (>) at the top of the calendar displays the next month 
in the future, and the single backwards arrow (<) displays the previous month.  The 
double arrows (>> or <<) cause the calendar to display a year in the future or past, 
respectively.  

12.2.2 Buttons 

Apply      
Apply button saves data entered on the current page  

Cancel       

Cancel button returns the user to the previous window without executing any function on 
the opened window 

Clear        
Clear button clears all information entered in the window 
 
Close         
Close button closes the open window 
 
Delete       
Delete button deletes the selected data  
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Reset      
Reset button returns the window to the last state before a save  
 
OK      
OK button returns the user to the previous window and saves any data that was added 
or updated 
 
Submit     
Submit button saves order information to the database after verification of edits and 
electronically transmits select order information to NYSPIN  
 

SAND Controls                                                                                  
The trio of buttons, Select, Add/New, and Delete are used throughout the application 
and are commonly referred to as the SAND Controls.  These buttons maintain the same 
functionality in all areas of the application.   
 
Select      
Select button allows the user to update or edit specified data within a specific row of a 
table once the data has been highlighted 
 
Add/New     
Add/New button allows the user to add new information to a specified table 
 
Delete       
Delete button allows the user to remove existing data from a row within a table once the 
data has been highlighted  
 
 
 
 
 
 
 
 
 

Office of Court Administration  60 
Division of Technology  

 



 
 
 
WebDVS User Manual 

Office of Court Administration  61 
Division of Technology  

 

12.3 Access Levels 
Below is a list of access levels for the application along with a description of the 
permission allowed for each.  
 
In addition to the specific permissions allowed for each access level, there are also 
permissions based on the logged in court.  
 
 
DA (District Attorney) Access 
 Add New 
 In Process 
 
 
Inquiry Only Access 
 Inquiry  
  View Order Details 
  View Order (PDF) 
  Order Recap 
 
 
Data Entry User 
 Inquiry 
  View Order Details 
  View Order (PDF) 
  Order Recap 
  Extend TOP 
  Copy/Modify 
  Edit Existing 
  Violations 
  Vacate Order(s) 
  Dismiss Case 
  Seal Case   
 Add New 
 Edit Existing 
 In Process 
 Reports 
  Order Number List 
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Local Supervisor 
 Inquiry 
  View Order Details 
  View Order (PDF) 
  Order Recap 
  Extend TOP 
  Copy/Modify 
  Edit Existing 
  Violations 
  Vacate Order(s) 
  Dismiss Case 
  Seal Case 
 Add New 
 Edit Existing 
 In Process 
 Reports 
  Expired Temporary Orders 
  Order Number List 
  Orders by Court or County 
  Orders with No Service – Details 
  Orders with No Service – Totals 
  Outstanding Violation Report 
  Outstanding Warrant Report 
  User Workload 
 (Un)Seal 
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12.4 Options (Functions)  
The following options are available to all courts and all users, even if the order 
originated from another court: 
 
 Inquiry 
 View Order Details 
 View Order (PDF) 
 Order Recap 
 
The following options are only available to users within a specified court: 
 
 Edit Existing 
 Extend TOP 
 Copy/Modify 
 Violations 

Vacate (exception:  Supreme and County users can vacate lower court  
  orders entered by courts within the same county) 

 Dismiss 
 (Un)Seal 
 
The following option is only available to Supreme and County court users for orders 
entered by a court within their county: 
 

Transfer/Vacate 
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